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கற்றலின் ந�ோககஙகள்

இந்த போடத்்தக கற்றபின் மோணவரகள் அறிநது 

ககோள்ப்வ

• இயகக அ்மப்பின் கருததுருகக்ைத 

க ்த ரி ந து க க ோ ள் ளு ்த ல் .

• விணநடோஸ் இயகக அ்மப்பின் பதிப்புக்ை 

அறிநது ககோள்ளு்தல். 

• முகப்புததி்ை மறறும் சன்்னல் தி்ையின் 

கூறுகளின் கருததுருகக்ைத அறிநது 

க க ோ ள் ளு ்த ல் .

• ஆவண சன்்னல் தி்ை்ய ஆைோய்தல்

• பல்நவறு வ்கயோ்ன பணிககுறிக்ை 

ஒ ப் பி டு ்த ல் .

• விணநடோஸ் நகோப்பு்்ற அ்டவு அ்மப்்ப  

ஆைோய்தல்.

• ஒரு குறிப்பிடட இயககவடடில் 

நகோப்புக்ையும், நகோப்பு்்றக்ையும், 

உருவோககுவ்தறகோ்ன பயிறசி.

• நகோப்புக்ையும், நகோப்பு்்றக்ையும் 

நி ர வ கி த ்த ல் .

• மு்்றப்படி ஒரு கணிப்கபோறியின் 

இயககத்்தத க்தோடஙகு்தல் மறறும் நி்்றவு 

க ச ய ்த ல் .

5.1. இயகக அ்மப்பு ஓர அறிமுகம் 
 இயகக அ்மப்பு (Operating  System) 
ஒரு அ்மப்பு கமன்கபோருள் (System Software) 
ஆகும். இது வன்கபோருடக்ை, மற்ற 

போடம் 5கணினி அறிமுகம்

கமன்கபோருடகளுடன் க்தோடரபு ககோள்ைவும், 

இயககவும் வ்க கசயகி்றது. நமலும், 

பய்ன்ையும், வன்கபோருடக்ையும் இ்ணககும் 

இ்டமுகமோகவும், கணிப்கபோறியின் 

அ்்னதது இயககஙக்ைக கடடுப்படுத்தவும் 

பயன்படுகி்றது. (படம் 5.1)
1 பய்னர 2 பய்னர n பய்னர

கமன்கபோருள்

அ்மப்பு 
கமன்கபோருள்

பயன்போடடு
கமன்கபோருள்

இயகக அ்மப்பு

வன்கபோருள்  ்மய 
கசயலகம் நி்்னவகம்

உள்ளீடு /
கவளியீடு

படம் 5.1 இயகக அ்மப்பு ஒரு போர்வ

 முந்்தய போடததில் கற்ற, இயகக 

அ்மப்பின் சில முககிய கசயல்போடுகள் பின் 

வ ரு ம ோ று :

• நி்்னவக நமலோண்ம

• கசயல் நமலோண்ம

• சோ்த்ன நமலோண்ம 

• நகோப்பு நமலோண்ம 

• போதுகோப்பு நமலோண்ம

• கணிப்கபோறி கசயல்போடுகளின் மீ்தோ்ன 

ஒடடுகமோத்த கடடுப்போடு

• பி்ை கணடறியும் சோ்த்னம்

• பய்னருககும் இ்தை கமன்கபோருள்களுககும் 

இ்டநயயோ்ன ஒருஙகி்ணப்பு.

அலகு I 

விணநடோஸ் - ல் நவ்ல கசய்தல்
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5.2. விணநடோஸ் இயகக அ்மப்பு ஓர 
அறிமுகம்

 ஒவ்கவோரு  கணிப்கபோறியும் 

இயஙகுவ்தறகு ஏந்தனும் ஒரு இயகக 

அ்மப்பு ந்த்வப்படுகி்றது. அந்த வ்கயில், 

்மகநைோசோப்ட விணநடோஸ் மிகவும் பிைபலமோ்ன 

ஒரு “வ்ைக்ல பய்னர இ்டமுகம்” (GUI - 
Graphics User Interface) இயகக அ்மப்பு 

ஆகும். விணநடோஸ்-ல் ஒநை ந�ைததில் 

ஒன்றுககும் நமறபடட பயன்போடுக்ை 

இயகக முடியும் இ்தறகு “பல்பணியோககம்” 

(Multitasking)  என்று கபயர.

 விணநடோஸ் இயகக அ்மப்பில், 
வி்சப்பல்க மறறும் சுடடி ஆகிய இைண்டயும் 
உள்ளீடடு சோ்த்னஙகைோகப் பயன்படுத்தலோம். 
சுடடி்ய பணிககுறிகளில் கிளிக கசயவ்தன் 
மூலம்,                 விணநடோஸ்-ல் கூறுகளுடன் எளிதில் 
கசயல்பட முடியும். வி்சப்பல்க, எழுததுககள், 
எணகள் மறறும் சி்றப்பு குறியீடுக்ை உள்ளிடப் 
பயன்படுகி்றது.

விணநடோஸ் இயகக அ்மப்பின் சில  
க ச ய ல் ப ோ டு க ள்

• கசோறகசயலிகள், அடடவ்ணச் கசயலிகள், 
கணிப்போன், வி்ையோடடுகள் நபோன்்ற  
பயன்போடுக்ை இயககுவ்தறகு.

• கணிப்கபோறியில் புதிய பயன்போடுக்ை 
நி று வு வ ்த ற கு .

• அச்சுப் கபோறி, வருடி, சுடடி, இலகக 
வ்க நகமைோ நபோன்்ற வன்கபோருள்க்ை 
நமலோண்ம கசயவ்தறகு.

• நகோப்பு மறறும் நகோப்பு்்றகள் உருவோககு்தல், 
பதிப்போயவு கசய்தல், நசமித்தல்,  
அழித்தல் நபோன்்ற நகோப்புநமலோண்ம 
கசயல்போடுக்ை கசயவ்தறகு.

• கணிப்கபோறியின் அ்மப்புகைோ்ன 
(Settings), வணண திடடஙகள் (Colour 
Scheme), தி்ைககோப்பு (Screen Savers) 
நபோன்்றவற்்ற தி்ையில்மோறறி அ்மகக.

அடடவ்ண 5.1 ல் விணநடோஸ் 
இயகக அ்மப்பின் பல்நவறு பதிப்புகள் 

ப ட டி ய லி ட ப் ப ட டு ள் ை து .

5.3. வின்நடோஸின் பல்நவறு பதிப்புகள்

பதிப்புகள் சின்்னம் ஆணடு முககிய சி்றப்பியல்புகள்

விணநடோஸ் 1.x

 

1985

(1) 16 பிடடுகளில் வ்ைக்ல பய்னர          இ்டமுகம் 
அறிமுகம் கசயயப்படடது.

(2) சுடடி, உள்ளீடடுச் சோ்த்னமோக அறிமுகம் 
கசயயப்படடது.

விணநடோஸ் 2.x 1987

• சன்்னல் தி்ை்ய சிறி்தோககு்தல், அல்லது 
கபரி்தோககு்தல் வசதி.  

• ்தனிப் பய்னோககு்தல்  விருப்பத ந்தரவுகள் 
(Customising Options) மறறும் கணிப்கபோறி 
அ்மப்பு (Computer System Setting) 
மோறறு்தல் நபோன்்ற சி்றப்பம்சஙகளுடன் 
”கடடுப்போடடுப் பலகம்” (Control Panel) 
அறிமுகம் கசயயப்படடது.

விணநடோஸ் 3.x 1992

• விணநடோஸ்-ல் “பல்பணி கருததுரு” 
(Concepts of Multitasking) அறிமுகம்.

• 256 வணணஙக்ை ஆ்தரிப்ப்தோல், 
அதி�வீ்ன வணணமயமோ்ன ந்தோற்றத்்த 
இ்டமுகததிறகு அளிககி்றது. 
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விணநடோஸ் 95 1995

• க்தோடகக கபோத்தோன், பணிப்பட்ட, 
விணநடோஸ் எகஸ்ப்நைோைர மறறும் 
க்தோடககப்படடி அறிமுகம்.

• 32 பிட கசயலி அறிமுகம் மறறும்  
பல்பணியோககம் மீது அதிக கவ்னம் 
க ச லு த ்த ப் ப ட ட து .

விணநடோஸ் 98 1998

• இயகக அ்மப்புடன், ஒருஙகி்ணந்த 
இ்ணய உலவி (இணடரக�ட எகஸ்ப்நைோைர 
- Internet Explorer) அறிமுகம்.

• DOS  அடிப்ப்டயிலோ்ன வி்ையோடடுகள்  
ம்்றயத க்தோடஙகி, விணநடோஸ் 
அடிப்ப்டயிலோ்ன வி்ையோடடுகள் 
ந ம ம் ப டு த ்த ப் ப ட ட து .

• கசருகி (Plug and play)  உபநயோகித்தல் 
சி்றப்பம்சம் அறிமுகம்.

விணநடோஸ் NT
• வ்லய்மப்பில் நச்வயகம் நபோல் 

வ டி வ ் ம க க ப் ப ட ட து .

விணநடோஸ் Me 2000
• ்தோனியஙகு  கணிப்கபோறி 

பரிநசோதித்தல் மறறும் மீடபுக கருவிகள் 
அ றி மு க ப் ப டு த ்த ப் ப ட ட ்ன .

விணநடோஸ் 
2000 2000

• வணிகநம்சக கனிணி மறறும் மடிக 
கனிணிகளில்  இயகக அ்மப்போக 
ந ச ் வ ய ோ ற றி ய து .

• விணநடோஸ் 2000ல் �ோன்கு பதிப்புகள் 
கவளியிடப்படட்ன.

• Professional (வணிக நம்சக கனிணி 
மறறும் மடிககணினிகள்)

• Server (இ்ணய நச்வயகம் மறறும் 
அலுவலக நச்வயகம்).

• Advanced Server (க்தோழில்து்்ற 
ப ய ன் ப ோ ட டி ற க ோ க )

• Data Centre Server (உயர நபோககுவைதது 
(high-traffic) கணிப்கபோறி நச்வயகம்). 

விணநடோஸ் XP 2001
• 64-பிட கசயலிகள் அறிமுகம்.

• வின்நடோஸ் ந்தோற்றம் மறறும் நி்லயோ்ன 
பணித்தைம் நமம்படுத்தப்படடது.

கோரடோ்னோ குைல் கசயலியகக ்தனி உ்தவியோைர வசதி (Cortana voice activated Personal assistant) 

5.4. சுடடி்யக ்கயோளு்தல் 

 விணநடோஸ் இயகக அ்மப்பில் நவ்ல 

கசயவ்தறகு முன்பு சுடடியின் இயககத்்தப் 

பறறி அறிநது ககோள்ை நவணடும்.
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விணநடோஸ் 
Vista 2006 • விணநடோஸ் ந்தோற்றம் நமம்படுத்தப்படடது.

விணநடோஸ்  7 2009

• கணிப்கபோறியின் க்தோடஙகு்தல் ந�ைம் 
நமம்படுத்தப்படடது.

• ஏநைோ பீக (Aero Peek), பணிப்பட்டயில் 
பயன்போடுக்ை இ்ணத்தல் (pinning 
programs to taskbar), ்ககயழுதது 
உணர்தல் (Handwriting recognition), 
இன்டரக�ட எகஸ்புநைோைர 8 (Internet 
Explorer 8) நபோன்்ற புதிய பய்னர இ்டமுக 
வசதிகள் அறிமுகப்படுத்தப்படடது.

விணநடோஸ் 8 2012

• விணநடோஸ்-ன் முந்்தய பதிப்புக்ை 
விட விணநடோஸ் 8 மிகவும் நவகமோக 
க ச ய ல் ப ட க கூ டி ய து . 

• க்தோடகக கபோத்தோன் நீககப்படடது.

• விணநடோஸ் 8 - யில் "பல் அடுககு கசயலி" 
(Multi Core Processing), திட நி்ல 
இயககிகள், க்தோடுதி்ை மறறும் மோறறு 
உள்ளீடடு மு்்றகள் நபோன்்ற சி்றந்த 
�ன்்மகள் உள்ை்ன.

• ்கப்நபசி மறறும் கணிப்கபோறிகளுககோ்ன 
கபோதுவோ்ன பணிநம்டயோக கசயல்படடது.

விணநடோஸ் 10 2015

• க்தோடகக கபோத்தோன் மீணடும் 
ந ச ர க க ப் ப ட ட து .

• ஒன்றுககும் நமறபடட தி்ை முகப்பு.

• "கசயலி அறிவிப்பு" மறறும் "வி்ைவு 
�டவடிக்க கசயலிககோ்ன மததிய அறிவிப்பு 
்மயம்" அறிமுகம்.

கோரடோ்னோ குைல் கசயலியகக ்தனி உ்தவியோைர வசதி (Cortana voice activated Personal assistant) 

5.4. சுடடி்யக ்கயோளு்தல் 

 விணநடோஸ் இயகக அ்மப்பில் நவ்ல 

கசயவ்தறகு முன்பு சுடடியின் இயககத்்தப் 

பறறி அறிநது ககோள்ை நவணடும்.

(Cortana voice activated Personal assistant)
வலது கிளிக

இடது கிளிக
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படம் 5.2.சுடடியின் கசயல்போடுகள்

சுடடியின் கசயல்போடுகள்

கசயல் வி்ைவு

ஒரு உருப்படி்ய 
(item) சுடட 

சுடடி்ய ஒரு உருப்படியின் மீது 
�கரதது்தல்.

கிளிக

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது இடது கபோத்தோ்்ன 
அழுததி உடந்ன விடடுவிடு்தல்.

வலது கிளிக

ஒரு உருப்படியின் மீது சுடடி்ய 
்வதது, வலது கபோத்தோ்்ன 
அழுத்த, ஒரு நமல்மீடபுப் படடி 
ந்தோன்றும், அதில் பல விருப்பத 
ந்தரவுகள் படடியலிடப்படும்.

இரு கிளிக 
கசய்தல்

தி்ையில் உள்ை ஒரு 
உருப்படியின் மீது சுடடி்ய 
்வதது, இடது கபோத்தோ்்ன 
இருமு்்ற நவகமோக அழுததி 
வி டு ்த ல் .

இழுதது விடு்தல்

ஒரு உருப்படியின் மீது 
சுடடி்ய ்வதது, சுடடியின் 
இடது கபோத்தோ்்ன அழுததி 
பிடித்தவோறு, சுடடி்ய 
ந்த்வயோ்ன இடம் வ்ை 
இழுதது, பின் விடடுவிடு்தல்.

அடடவ்ண  5.2
5.5. விணநடோஸின் தி்ைமுகப்பு

விணநடோஸின் க்தோடகக தி்ை ”தி்ைமுகப்பு”  
(Desktop) என்று அ்ைககப்படுகி்றது. 
உஙகள் கணிப்கபோறியில் உள்ை தி்ை முகப்பு 
படம்  5.3ல் கோடடப்படடது நபோல இல்லோமல் 
நவறுபடடிருககலோம். ஏக்னனில் விணநடோஸ் 
அ்தன் ந்தோற்றம், தி்ை முகப்பு ஆகியவற்்ற 
மோறறி அ்மகக வழி கசயகி்றது.
படம் 5.3 -ல் க்தோடகக கபோத்தோன், 
பணிப்பட்ட, அறிவுப்புப் பகுதி, ந்ததி 
மறறும் ந�ைம் ஆகியவற்்றத தி்ைமுகப்பில் 
க ோ ண ல ோ ம் .

• நீஙகள் எந்த பயன்போடடில் நவ்ல கசயது 

ககோணடிருந்தோலும் Winkey + D அல்லது 

ஏநைோ பீக (Aero Peak) பயன்படுததி எந்த 

ந�ைததிலும் தி்ை முகப்புககுச் கசல்லலோம்.

• பணிப்பட்டயில் ஏநைோ பீக எஙகு உள்ைது 

என்ப்்த படம் 5.4ல் அறியலோம்.

உஙகளுககு க்தரியுமோ?

பணிககுறிகள்

பணிப்பட்ட

அறிவிப்பு பகுதிக்தோடகக கபோத்தோன்

நககஜடடுகள்

படம் 5.3. ்மகநைோசோப்ட விணநடோஸ் 7 

தி்ைமுகப்புதி்ைமுகப்பு

ஏநைோ பீக கபோத்தோன்

படம் 5.4. ஏநைோ பீக கபோத்தோன்.

5.5.1. பணிககுறிகள் (Icon)
 விணநடோஸ்-ன் கூறுகைோ்ன நகோப்பு, 

நகோப்பு்்ற, குறுககுவழிகள் நபோன்்றவற்்றக 

குறிககும் படககுறியீடு "பணிககுறி" எ்னப்படும். 

வ்ைக்லப் பய்னர இ்டமுக (GUI) 

பயன்போடுகளில் பணிககுறிகள் முககிய பஙகு 

வ கி க கி ்ற து .

5.5.1.1 கசந்தை பணிககுறி (Standard 
Ic ons)
  விணநடோஸ் இயகக அ்மப்பு 

நிறுவப்படும் நபோது உருவோககப்படும் ககோடோநி்ல 

பணிககுறிகள், "கசந்தை பணிககுறிகள்" 

(Standard Icons) எ்ன அ்ைககப்படுகி்றது. 

்மகம்ப்யூடடர (My Computer), டோககுகமன்ட 
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(ஈ) ்கப்நபசி, ஸ்மோரட ்கப்நபசி, நடப்ைட 

(Tablet) நபோன்்ற நீககககூடிய நி்்னவகஙகள்

(உ) உஙகள் கணிப்கபோறி பி்ற கணிப்கபோறிகளுடன் 

இ்ணககப்படடு இருந்தோல், அ்தன் வ்ல 

இயககி (படம் 5.6 போரகக)

பயன்போடடு பணி-
ககுறி

நகோப்பு்்ற 
பணிககுறி

படம் 5.5.பணிககுறியின்  வ்ககள்

(Documents) மறறும் ரி்சககிள் பின் (Recycle 
Bin) நபோன்்ற்வ அ்்னதது விணநடோஸ் 

இயகக அ்மப்புகளிலும் கோணப்படும் கசந்தைப் 

பணிககுறிகள் ஆகும். 

5.5.1.2. குறுககு வழி பணிககுறிகள் :

 எநக்தவோரு பயன்போடு அல்லது  நகோப்பு 

அல்லது நகோப்பு்்றகளுககு குறுககு வழி 

பணிககுறிக்ை உருவோககலோம்.  இ்தன் மீது இரு 

கிளிக கசயயப்படும் நபோது இ்தறகோ்ன பயன்போடு 

/ நகோப்பு அல்லது நகோப்பு்்ற தி்றககப்படும்.  

குறிப்பிடட பயன்போட்டத தி்றப்ப்தறகோ்ன  

குறுககுவழியோக பணிககுறிகள் பயன்படுகி்றது. 

(படம் 5.5).

5.5.1.3. வடடு இயககி பணிககுறிகள் 

 வடடு இயககி பணிககுறிகள், ஐநது 

வ்கயோ்ன வடடு இயககிக்ைப் படககுறியீடோக 

வ ை ங கு கி் ்ற து .

(அ) வன்வடடு (C,D,E) 

(ஆ)CD-ROM / DVD வடடு

(இ) கபன்டி்ைவ் (Pen Drive)

பல்நவறு வடடு இயககி 

பணிககுறி

கமோத்த நி்்னவக இடம் 

மறறும் மீ்தமுள்ை நி்்னவக 

இடததுடன் வன்வடடு இயககி

நீககக கூடிய நி்்னவகம் (கபன் இயககி)

படம் 5.6.வடடு இயககி பணிககுறிகள்

5.6. சன்்னல் தி்ை

 ஒரு ஆவணம் அல்லது பயன்போடடின் கபோதுவோ்ன கசவ்வகப் பகுதி "சன்்னல்" தி்ை எ்னப்படும். 
குறிப்பிடட பயன்போடடின் ்தகவல்க்ைத தி்ையிடுவ்தறகு  பயன்படும் பகுதியோகும்.
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5.7 பயன்போடடு சன்்னல்தி்ை

 ்தகவல்க்ைத தி்ையிடுவ்தறகோ்ன, 
வ்ையறுககப்படட எல்்லக்ைக ககோணட 
கணிப்கபோறி தி்ையின் பகுதி, "பயன்போடடு 
சன்்னல்தி்ை" எ்னப்படும். சன்்னல் தி்ைக்ை 
சிறி்தோககு்தல் (Minimize), கபரி்தோககு்தல் 
(Maximize), அருகருநக ்வத்தல் (side 
by side), ஒன்்றன் மீது ஒன்்றோக ்வத்தல் 
(Overlap) நபோன்்ற கசயல்க்ைச் கசயய 
முடியும். ஒரு பயன்போடடு சன்்னல்தி்ை என்பது 
தி்றககப்படடுள்ை ஒரு  பயன்போடு. அ்தோவது Word, 
Paint நபோன்்ற இயஙகும் பயன்போடுக்ைக 
குறிககும். இைணடுககும் நமறபடட சன்்னல்கள் 
தி்றநதிருககும் நபோது அ்தனுள் ஒன்று மடடுநம 
கசயலில் இருககும். மற்றது கசயலற்ற்தோக 
இருககும். படம் 5.7 மறறும் 5.8 ல் ஓபன் ஆஃபீஸ் 
்ைடடர பயன்போடடு சன்்னல் தி்ை மறறும் தி்ை 
முகப்பில் தி்றநதுள்ை ஒன்றுககும் நமறபடட 
சன்்னல்களின் ந்தோற்றத்்தக கோணலோம்.

5.8. ஆவண சன்்னல் தி்ை

 ஒரு ஆவணததின் உள்ைடககத்்தக 

கோடடும் சன்்னல் தி்ை "ஆவண சன்்னல் 

தி்ை"  எ்னப்படும். படம் 5.9 ல் ஆவண சன்்னல் 

தி்ைககோ்ன எடுததுககோடடோகும்.
குறிப்பு

ஓபன் ஆஃபீஸ் ்ைடடர, இம்ப்கைஸ் 
அல்லது கோல்க நபோன்்ற பயன்போடுக்ைத 
தி்றககும் நபோது, கணிப்கபோறி தி்ையில் 
இைணடு சன்்னல் தி்ைகள் ஒன்றினுள் 
ஒன்்றோக ந்தோன்றும். அதில், கபரிய 
சன்்னல் தி்ை “பயன்போடடு சன்்னல் தி்ை” 
என்று அ்ைககப்படுகி்றது. இது, பய்னர, 
பயன்போடடு கமன்கபோருளுடன் க்தோடரபு 
ககோள்ைப் பயன்படுகி்றது. பயன்போடடு 
சன்்னல் தி்ையின் உள்நை அ்மநதுள்ை 
சிறிய சன்்னல் தி்ை “ஆவண சன்்னல் 
தி்ை” என்று அ்ைககப்படுகி்றது. இது, 
உ்ை மறறும் படஙக்ை (graphics) 
உருவோககவும், பதிப்போயவு கசயயவும், 
படஙக்ை வ்ையவும் மறறும் வடிவூடடல் 
கசயயவும் பயன்படுகின்்றது.

பயன்போடடு பணித்தைம்

ஆவணததின் ்த்லப்புடன் "்த்லப்புப் பட்ட"

கருவிப் பட்ட

உருைல் பட்ட

படடிப் பட்ட

வி
ண

ந
ட

ோஸ்
 க

ட
டு

ப்போட
டு

 கபோத
்த

ோன்
க

ள்
 

படம் 5.7. பயன்போடடு சன்்னல்தி்ை

படம் 5.8. ஒன்றுககும் நமறபடட சன்்னல்கள் 

தி்ைமுகப்பில் தி்றககப்படடுள்ைது
பயன்போடடு சன்்னல்

ஆவண பகுதி

ஆவண சன்்னல்

ரூலர

படம்  5.9.ஆவண சன்்னல் தி்ையின் கூறுகள்
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5.9. சன்்னல் தி்ையின் கூறுகள்

 படம் 5.10 சன்்னல் தி்ையின் 

கூறுக்ைப்ப புரிநது ககோள்ை பயன்படுகி்றது.

 சிறி்தோககு, கபரிய்தோககு மறறும் மூடு 

கபோத்தோன்களும் உள்ை்ன.

5.9.1 ்த்லப்புப்பட்ட

 தி்றநதுள்ை ஆவணததின் கபயரும், 

பயன்போடடின் கபயரும் ்த்லப்புப் பட்டயில் 

ந ்த ோ ன் று ம் .

5.9.2 படடிப்பட்ட

 ்த்லப்பு பட்டயின் கீழ் பு்றம் 

படடிப்பட்ட கோணப்படும். Alt கபோத்தோ்்ன 

அழுததியவோந்ற படடித ்த்லப்பில் அடிநகோடிடடு 

ந்தோன்றும் எழுததி்்னயும் அழுததி, 

படடிப்பட்டயில் உள்ை படடிக்ைப் பயன்படுத்த 

முடியும். நமலும் Alt கபோத்தோன் அல்லது F10 
கபோத்தோ்்ன அழுததி்னோல் படடிபட்டயில் 

உள்ை மு்தல் படடி்ய முன்னிறுததும். 

 விணநடோஸ் 7  இல் படடி பட்ட 

இல்லோவிடடோல் organize கபோத்தோனில் களிக 

கசயது ந்தோன்றும் கீழ்விரிப் படடியிலிருநது 

layout Option கிளிக கசயது படடிப் 

பட்ட்யத ந்தோன்்றச்கசயயலோம். படம் 5.11ன் 
மூலம் படடி பட்ட ந்தோன்்றோவிடடோல் அ்்த 

எவ்வோறு ந்தோன்்றச் கசயவது என்ப்்தத க்தரிநது 

க க ோ ள் ை ல ோ ம் .
மூ்லகள்

மூ்லகள் மூ்லகள்

உருைல் பட்ட

பணித்தைம்

Menu Bar

மூ்லகள்
்த்லப்புப் பட்ட

எ
ல்

்
ல

க
ள்

எல்்லகள்

எல்்லகள்

படம்  5.10. விணநடோஸின் கூறுகள் 

படம்  5.11. படடிப் பட்ட்ய ந்தோன்்ற கசயவது

5.9.3. பணித்தைம் 
 ஒரு ஆவணததில் உ்ை்யத ்தடடச்சு 
கசயயும் ஆவண சன்்னல் தி்ையின் பகுதி 
பணித்தைம் ஆகும். படம்  5.10 ஆவண 
சன்்னலின் பணித்தைத்்தக கோடடுகி்றது.
5.9.4 உருைல் பட்ட
 உருைல் பட்டகள் பணித்தைத்்தச் 
கசஙகுத்தோகவும், கி்டமடடமோகவும் உருை 
கசயயப் பயன்படுகி்றது. படம் 5.10 உருைல் 
பட்டயின் ந்தோற்றத்்தக கோடடுகி்றது.
5.9.5 மூ்லகள் மறறும் எல்்லகள்
 விணநடோஸில் அை்வ மோறறி அ்மகக 
மூ்ல மறறும் எல்்ல உ்தவி கசயகி்றது.
சன்்னல் தி்ையின் மூ்லகள் மறறும் 
எல்்லகளின் மீது சுடடியின் அம்புககுறி்ய 
்வககும்நபோது, அது இரு்த்ல ககோணட 
அம்புககுறியோக மோறும். இரு்த்ல 
அம்புககுறியின் தி்சககு ஏறப இழுககும் நபோது, 
சன்்னல் தி்ையின் அைவு மோறும் (படம் 5.10்ய 
கோணக). சன்்னலின் மூ்லவிடடததில் இரு்த்ல 
அம்புககுறி்ய ்வதது இழுககும்நபோது, அ்தன் 
அைவு மோற்றப்படும். 

5.10 கணினி்ய ஆைோய்தல்

5.10.1 க்தோடககப்படடி
 தி்ைமுகப்பின் கீழ் இடது ்க 
மூ்லயில் க்தோடகக கபோத்தோன் உள்ைது. 
க்தோடகக கபோத்தோ்்னக கிளிக கசயயும் 
நபோது க்தோடககப்படடி ந்தோன்றும். நமலும் 
அ்்த பயன்படுததி எந்த ஒரு பயன்போட்டயும் 
க ்த ோ ட ங க ல ோ ம் .
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பணிப்பட்ட

 தி்ைமுகப்பின் கீநை உள்ை 
கி்டமடட பட்ட “பணிப்பட்ட” (Taskbar) 
என்று அ்ைககப்படுகி்றது. இந்த பட்ட, 
(இடமிருநது வலமோக) க்தோடககப் கபோத்தோன், 
பல்நவறு பயன்போடுகளின் குறுககுவழிகள், 
சிறி்தோககப்படட பயன்போடுக்ை 
ககோணடிருககும். நமலும், அ்தன் வலதுநகோடியில், 

ஒலி கடடுப்போடடகம், வ்லய்மப்பு, ந்ததி 
மறறும் ந�ைம் நபோன்்ற வசதிக்ை உள்ைடககிய 
”கணினி அ்மப்பு ்தடடு” (System tray)  
உள்ைது. அடிககடி பயன்படுத்தப்படும் 
பயன்போடுக்ைக ககோணடிருககும். ”வி்ைவு 
க்தோடகக கருவிப்பட்ட” (Quick launch 
toolbar), க்தோடகக கபோத்தோனுககு அடுத்த்தோக 
உ ள் ை து .

இந்த ந்தரவுடன் நமலும் 
து்ணப்படடி உள்ை்்தக 
கோடடும் குறியீடு.

கணிப்கபோறி அ்மப்்ப  
மோறறுவது

(கடடுப்போடடு பலகம்)

இ்தை சோ்த்னஙகள் மறறும் 
அச்சுப்  

கபோறிக்ைச் நசரத்தல் / 
மோறறு்தல்

உ்தவி கபறு்தல்

கவளிநயறு்தல் / மீணடும்  
க்தோடஙகு்தல், பணி  நிறுத்தம்

நிறுவப்படட 
பயன்போடுகள்

ந்தடல் கபடடி

க்தோடகக 
கபோத்தோன்

படம் 5.12.க்தோடகக படடி 
க்தோடககப் கபோத்தோன்

சிறி்தோககப்படட 
பயன்போடுகளும், நகோ-

ப்பு்்றகளும்

ம்்றககப்படட பணி-
ககுறிக்ைக கோடடும்

்தோ்ன்மவு 
கமோழி

வ்லய்மப்பு 
பணிககுறி

ஒலி சரிகச-
ய்தல்

ந�ைம் மறறும்  �ோள்

ஏநைோபீக 
கபோத்தோன்

படம்  5.13 படடிப்பட்ட
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5.10.2 கணிப்கபோறி பணிககுறி

 இந்த பணிககுறி்யக கிளிக கசய்தோல், 
கணிப்கபோறியுடன் இ்ணககப்படடுள்ை 
வடடு இயககிக்ைப் பய்னர கோண முடியும். 
விணநடோஸ் XP மறறும் விஸ்டோ பதிப்புகளில், 
இந்த பணிககுறி “்ம கம்ப்யூடடர” (My 
Computer) என்றும், விணநடோஸ் 8 மறறும் 
10ல் ”திஸ் பீஸி” (This PC) என்றும் 
அ்ைககப்படுகி்றது. இந்த பணிககுறியின் 
கசயல்போடு விணநடோஸ்-ன் அ்்னதது 
பதிப்புகளுககும் கபோதுவோ்ன்தோகும். (படம்  
5.14 ்ய கோணக)

5.10.3 பயன்போட்டத க்தோடஙகு்தல் மற்றம் 
மூ டு ்த ல் 
 கணிப்கபோறியில் நிறுவப்படடுள்ை 
கபரும்போலோ்ன பயன்போடுகள், க்தோடககப்படடியில் 
கி்டககும். கணிப்கபோறியின் அ்மப்்பப் 
கபோறுதது க்தோடககப் படடியில் உள்ை பயன்போடுகள் 
ந வ று ப டு கி ன் ்ற ்ன . 

1. ஒரு பயன்போட்டத க்தோடஙகுவ்தறகு: Start 
கபோத்தோ்்னக கிளிக கசயது, All Programs 
ல் சுடடி்ய ்வககவும்.  நிைல் படடி படம் 5.15 
ல் உள்ைவோறு ந்தோன்றும்.

2. நீஙகள் க்தோடஙக விரும்பும் பயன்போட்டக 
ககோணட குழுவில் சுடடி்ய ்வதது, பின்்னர 

பயன்போடடின் கபய்ைக கிளிக கசயயவும்.

படம்  5.14 விணநடோஸ் இயகக அ்மப்பு பதிப்பில் உள்ை ்மகம்ப்யூடடர பணிககுறி

படம் 5.15 க்தோடககப் கபோத்தோ்்னப் 

பயன்படுத்த பயன்போட்டத க்தோடஙகு்தல்.

3. க்தோடகக  படடியிலுள்ை Run என்ப்்தக கிளிக 

கசயது, ந்தோன்றும் கபடடியில், தி்றககப்பட 

நவணடிய பயன்போடடின் கபய்ைத ்தடடச்சு 

கசயதும், ஒரு பயன்போட்டத க்தோடஙகலோம். 

(படம் . 5.16   ்ய கோணக)

படம்  5.16. Run கடட்ை்யப் பயன்படுததி 

பயன்போட்டத க்தோடஙகு்தல்

4. ஒரு பயன்போட்ட விடடு கவளிநய்ற 

பயன்போடடு சன்்னல் தி்ையின் நமல் வலது 

மூ்லயில் உள்ை மூடு கபோத்தோ்்னக கிளிக 

கசயக. (படம் 5.17)

XI Std Computer Science Vol-1 TM Chapter 5 090-130.indd   61 4/21/2020   4:33:39 PM



62

மூடு கபோத்தோன்

கவளிநயறு

படம் 5.17. மூடு (Close) மறறும் கவளிநயறு (Exit)
கபோத்தோ்்னப் பயன்படுததி கவளிநயறு்தல்

5.  File → Exit அல்லது File → Close 

கடட்ைக்ை்யப் பயன்படுததியும், ஒரு 

பயன்போடடிலிருநது கவளிநய்றலோம்.

பயிறசி படட்்ற

 க்தோடககப்  படடி மறறும் RUN ந்தரவு 
பயன்படுததி Word Pad பயன்போட்டத 

க ்த ோ ட ங கு க .

 File படடி்யப் பயன்படுததி Word Pad ஐ 

மூடுக.

5.11 நகோப்புக்ையும், 
நகோப்பு்்றக்ையும் நிரவகித்தல்

 விணநடோஸ் 7 ல், ஆவணஙகள் மறறும் 
நிைல்க்ைக நகோப்புகள் மறறும் நகோப்பு்்றகைோக  
நிரவகிககலோம். நகோப்பு மறறும் நகோப்பு்்றக்ை 
�கரதது்தல், �ககலடுத்தல், மோறறுப்கபயரிடு்தல், 
நீககு்தல் மறறும் ந்தடல் நபோன்்ற கசயல்க்ைச் 
கசயய முடியும்.

5.11.1. நகோப்பு மறறும் நகோப்பு்்றக்ை 

உ ரு வ ோ க கு ்த ல்

5.11.1.1 நகோப்பு்்றக்ை உருவோககு்தல்

 உஙகள் நகோப்புக்ைப் பல இடஙகளில் 

நசமிககலோம் - வன்வடடு அல்லது பி்ற 

இயககிகளில். உஙகள் நகோப்புக்ை சி்றப்போக 

அ்மகக நகோப்பு்்றகளில்  நசமிககலோம். 

புதிய நகோப்பு்்ற்ய உருவோகக இைணடு 
வழிமு்்றகள் உள்ை்ன.

மு்்ற 1
படி 1. கம்ப்யூடடர குறும்படத்்த தி்றககவும்

படி2. புதிய நகோப்பு்்ற்ய உருவோகக விரும்பும் 
இயககி்ய தி்றககவும். (உ்தோைணம் D:/)

படி3. File  New  Folder கிளிக கசயக.

படி4. புதிய நகோப்பு்்ற, ்தோ்ன்மவோக “New 
Folder” எ்ன (படம் 5.19) கோடடியவோறு 
உ ரு வ ோ கு ம் .

படி 5. நகோப்பு்்றயின் கபய்ைத ்தடடச்சு 
கசயது, Enter கபோத்தோ்்ன அழுத்தவும். 
(புதிய்தோக உருவோககப்படட நகோப்பு்்ற  
"test folder" எ்ன கபயரிடப்படடுள்ை்்தப்  
படம் 5.20 கோணக)

படம் 5.18. File படடி்யப் பயன்படுததி 

நகோப்பு்்றக்ை உருவோககு்தல்.

படம் 5.19 ்தோ்ன்மவு கபயரில் புதி்தோக 

உருவோககப்படட நகோப்பு்்ற
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படம் 5.20. புதி்தோக உருவோககப்படட 
நகோப்பு்்றககு  மறுகபயரிடு்தல்.

மு்்ற 2
தி்ைமுகப்பில் நகோப்பு்்ற்ய உருவோகக

படி 1-  தி்ைமுகப்பில் சுடடியின் வலது 
கபோத்தோ்்னக கிளிக கசயது, New 
 Folder  கடட்ை்யக கிளிக கசயக. 
(படம் 5.21)

படி 2-  கபயரிடப்படோ்த ஒரு new folder என்்ற 
நகோப்பு்்ற ந்தோன்றுகி்றது (படம் 5.22)

படி 3-  நகோப்பு்்றககு ஒரு கபயர ்தடடச்சு 
கசயது. Enter கபோத்தோ்்ன 
அ ழு த ்த வு ம் .

படி 4 –  நகோப்பு்்றயின் கபயர மோற்றம் கபறும். 
(படம் 5.20)

2. ்ம டோககுகமன்ட (My Document) ல், �ோம் 
பயின்்ற ஏந்தனும் ஒரு மு்்ற்யப் பயன்படுததி 
ஒரு நகோப்பு்்ற்ய உ்னது கபயரில் 
உருவோககவும். 

பயிறசி படட்்ற

5.11.1.2 நகோப்பு உருவோககு்தல் (நவரடு நபட)
நவரடு நபட (Word Pad) விணநடோஸ் இயகக 
அ்மப்பின் உள்ளி்ணந்த கசோறகசயலி 
பயன்போடோகும். உ்ை ஆவணஙக்ை 
உருவோககவும், ்கயோைவும் இது 
ப ய ன் ப டு கி ்ற து . 
 இதில் நகோப்பி்்ன உருவோகக 
விரும்பி்னோல் கீழ்ககோணும் படிநி்லக்ைப் 
பி ன் ப ற ்ற வு ம் .

படம் 5.21. தி்ை முகப்பில் நகோப்பு்்ற்ய 

உருவோககு்தல்.

1.  Start  All Programs  Accessories  
Wordpad அல்லது Run  type Wordpad 
எ்ன ்தடடச்சு கசய்த பி்றகு ok கபோத்தோ்்னக 

கிளிக கசயய நவணடும்.

 Word Pad சன்்னல் தி்ை படம் 5.23 ல் 

கோடடியுள்ைவோறு தி்றககப்படும்.

2. பணித்தைததில் ்தடடச்சு கசயயப்பட 

நவணடிய உ்ை்யத ்தடடச்சு கசயது, File 

 Save அல்லது Ctrl + S  பயன்படுத்தவும். 
3. Save As உ்ையோடல் கபடடி தி்ையில் 

ந ்த ோ ன் று ம்

4. அந்த உ்ையோடல் கபடடியில் ஆவணத்்த 

எஙகு நசமிகக நவணடுநமோ அ்்த  
look –in கீழி்றககுப்  கபடடியில் ந்தரவு கசயய 

நவணடும்.

5. File name என்்ற உ்ைப்கபடடியில் நகோப்பின் 

கபய்ைத ்தடடச்சு கசயய நவணடும்.

6. Save கபோத்தோ்்னக கிளிக கசயய நவணடும் 

படம் 5.22. தி்ைமுகப்பில் புதிய நகோப்பு்்ற
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படம்  5.23.Word pad- கசோறகசயலி பயன்போடு

3. Wordpad- ்ய பயன்படுததி ஒரு 
ஆவணத்்த உருவோககி பின் அ்்த 
்ம டோககுகமன்டில் உள்ை உஙகள் 
கபயரில் உருவோககப்படட நகோப்பு்்றயில் 
ந ச மி க க வு ம் .

பயிறசி படட்்ற

5.11.2. நகோப்பு மறறும் நகோப்பு்்றக்ைத 
ந்தடு்தல்

கணினியில் அல்லது குறிப்பிடட இயககிகளில் 

உள்ை நகோப்பு அல்லது நகோப்பு்்ற்ய வி்ைவோக 

க்தோடககப் கபோத்தோனிலுள்ை Search கபடடி 

பயன்படுத்தப்படுகி்றது.

படம் 5.24. க்தோடகக படடி்யப் பயன்படுததி 

நகோப்பு அல்லது நகோப்பு்்ற்யக கணடுபிடித்தல்.

நகோப்பு அல்லது நகோப்பு்்ற்யக கணடுபிடிகக

1. Start கபோத்தோ்்ன கிளிக கசயயவும், 
க்தோடகக படடியின் க்டசியில் Search 
கபடடி கோணப்படும்.

2. ந்தடப்பட நவணடிய நகோப்பு அல்லது 
நகோப்பு்்றயின் கபய்ை Search  
கபடடி - ல் ்தடடச்சு கசயக. ந்தடநவணடிய 
நகோப்பு அல்லது நகோப்பு்்றயின் கபயரில் 
ஒரு பகுதி்ய நீஙகள்ககோடுத்தோநல 
நபோதும்.

3. குறிப்பிடப்படட கபயரிலுள்ை நகோப்பு அல்லது 
நகோப்பு்்றகள் தி்ையில் ந்தோன்றும். அந்த 
நகோப்பு அல்லது நகோப்பு்்ற்ய கிளிக 
கசய்தோல், அது ந�ைடியோக தி்றககும்.

4. Search கபடடிககு நமநல “See more 
results” என்்ற மறக்றோரு ந்தரவும் உள்ைது.

5. இந்த ந்தர்வக கிளிக கசயயும் நபோது, 
Search Results உ்ையோடல் கபடடி 
ந்தோன்றும். இ்தன் மூலம், நகோப்பு அல்லது 
நகோப்பு்்றக்ை ந்தடித, தி்றககலோம். 

நகோப்பு அல்லது நகோப்பு்்ற்ய கம்ப்யூடடர 
பணிககுறி  மூலம் ந்தடு்தல்.

படி 1 கம்ப்யூடடர பணிககுறி்ய தி்ை முகப்பில் 
ந்தரவு கசயக அல்லது Start படடி மூலம்  
ந்தரவு கசயக.

படி 2 கம்ப்யூடடர வடடு இயககி(Disk Drive) 
என்்ற தி்ை, நமல் வலது மூ்லயில் 
ந்தோன்றும்.அதில் Search box ந்தரவு 
உள்ைது. (படம் 5.25) 

படி 3 அதில் நகோப்பு அல்லது நகோப்பு்்றயின்  
கபய்ை ்தடடச்சு கசயக. நகோப்பு அல்லது 
நகோப்பு்்ற கபயரின் ஒரு பகுதி்ய  
ககோடுத்தோல் குறிப்பிடட கபயரில் 
க்தோடஙகும் அ்்னதது நகோப்பு அல்லது 
நகோப்பு்்றக்ைக கோடடும்.

படி 4 நகோப்பு அல்லது நகோப்பு்்ற்ய தி்றகக 
அ்த்்ன கிளிக கசயயவும்.
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படம் 5.25. 'கம்ப்யூடடர' பணிககுறி்யப் பயன்படுததி, நகோப்புஅல்லது நகோப்பு்்ற்யத ந்தடு்தல்.

4. நமநல கூறியுள்ை மு்்றக்ைப் 
பின்பறறி நீஙகள்  பயிறசி படட்்ற 3 ல் 
உருவோககிய நகோப்பி்்னத ந்தடவும்.

பயிறசி படட்்ற

5.11.3. முன்்னநை உருவோககிய நகோப்பு அல்லது 

நகோப்பு்்ற்யத தி்றத்தல்

நகோப்பு அல்லது நகோப்பு்்ற்யத தி்றகக மிக 

கபோதுவோ்ன வழி, அ்்த இைட்டக கிளிக 

கசய்தல் ஆகும்.

5.11.4 நகோப்பு அல்லது நகோப்பு்்றககு 

ம று க ப ய ரி டு ்த ல்

 நகோப்பு மறறும் நகோப்பு்்றககு 

மறுகபயரிடுவ்தறகு பல வழிகள் உள்ை்ன.

File படடி அல்லது இடது சுடடிப் கபோத்தோன் 

அல்லது வலது சுடடிப் கபோத்தோ்்னப் 

பயன்படுததி மறுகபயரிடலோம்.

மு்்ற 1

File படடி்யப் பயன்படுததி மறுகபயரிடு்தல்

1. மறுகபயரிட நவணடிய நகோப்பு அல்லது 

நகோப்பு்்ற்யக கிளிக கசயக.

2. கிளிக File -> Rename

3. புதிய கபய்ைத ்தடடச்சு கசயக.

4. படம் 5.26 ல் கோடடியபடி மறு கபயரிடும் 

கசயலி்்ன முடிகக  Enter  கபோத்தோ்்ன 

அழுத்தவும் அல்லது OK கபோத்தோ்்னக 

கிளிக கசயயவும்.

படம் 5.26. File படடி்யப் பயன்படுததி நகோப்பு 

அல்லது நகோப்பு்்றககு மறுகபயரிடு்தல்

படம் 5.27. மறுகபயரிடப்படட நகோப்பு்்ற படம்

5.27 SCERT  என்்ற  நகோப்பு்்ற SCERT-
DPI எ்ன மோறறு கபயரிடப்படடுள்ை்்தக 

கோணலோம்.
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மு்்ற   2 

சுடடியின் வலது கபோத்தோ்்னப் பயன்படுதது்தல்.

படி 1- மறுகபயரிட விரும்பும் நகோப்பு அல்லது 

நகோப்பு்்ற்யத ந்தரவு கசயக.

படி 2  நகோப்பு அல்லது நகோப்பு்்றயின் மீது 

சுடடியின் வலது கபோத்தோ்்னக கிளிக 

கசயக. (படம் 5.28)

படி 3 நமல் மீடபுப் படடித ந்தோன்றும். அதில் 

rename என்்ற கடட்ை்யத ந்தரவு  கசயக. 

படி 4  புதிய கபய்ைத ்தடடச்சு கசயக.

படி 5  மறு கபயரிடும் கசயலி்்ன முடிகக Enter   
அல்லது OK கபோத்தோ்்ன அழுத்தவும்.

படம்  5.29ல். New Folder  என்்ற நகோப்பு்்ற 

C++  எ்ன கபயர மோற்றம் கசயயப்படடுள்ைது.

படம் 5.28. நகோப்பு அல்லது நகோப்பு்்ற்யச் 

சுடடியின் வலது கபோத்தோ்்னப் பயன்படுததி  

மறுகபயரிடு்தல்

படம்  5.29. C++எ்ன கபயர மோற்றம் கசயயப்படட 
நகோப்பு்்ற

மு்்ற 3 
சுடடியின் இடது கபோத்தோ்்னப் பயன்படுததி 
மறுகபயரிடு்தல்.
படி 1-  மறுகபயரிட விரும்பும் நகோப்பு அல்லது 

நகோப்பு்்ற்யத ந்தரவு கசயக.
படி 2 – F2 கபோத்தோ்்ன அழுத்த நவணடும் 
அல்லது நகோப்பு அல்லது நகோப்பு்்றயின் மீது  
கிளிக கசயய நவணடும். நகோப்பின் கபய்ை சுறறி 
ஒரு கசவ்வக வடிவம் ந்தோன்றும்.
படி 3 – புதிய கபய்ைத ்தடடச்சு கசயக.
படி 4 – மறு கபயரிடும் கசயலி்்ன முடிகக Enter   

அல்லது  OK கபோத்தோ்்ன அழுத்தவும்.

5. நீஙகள் உருவோககிய நகோப்பி்்ன File 
படடி, இடது சுடடி, வலது சுடடி  பயன்படுததி 

மறுகபயரிடுக.

பயிறசி படட்்ற

5.11.5. நகோப்பு மறறும் நகோப்பு்்ற்ய 
�ககலடுத்தல் அல்லது �கரதது்தல்
 நகோப்பு  மறறும் நகோப்பு்்ற்ய பி்ற 
பகுதிகளுககு �கரததுவ்தறகு பல வழி மு்்றகள் 
உ ள் ை ்ன .
நகோப்பு மறறும் நகோப்பு்்ற்ய �கரதது்தல்:
மு்்ற 1-கவடடு்தல் மறறும்  ஒடடு்தல் 
• ஒரு நகோப்பு அல்லது ஒரு நகோப்பு்்ற்ய 

�கரததுவ்தறகு மு்தலில் ந்தரநக்தடுகக 
நவணடும். பி்றகு கீழ் வரும் வழி மு்்றகளில் 
ஏந்தனும் ஒன்்்ற கசயக.

• Edit → Cut அல்லது Ctrl + X அல்லது 
வலது சுடடி கபோத்தோ்்ன அழுததி்னோல் 
நமல் மீடபுப் படடித ந்தோன்றும். அதில் Cut 
என்ப்்த ந்தரவு கசயக.  

• நகோப்பு அல்லது நகோப்பு்்ற்ய புதிய 
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இடததிறகு �கரததுவ்தறகு Edit→ Paste  
அல்லது  Ctrl + V     என்்ற சோவி நசரமோ்னத்்த 
அல்லது வலது சுடடி கபோத்தோ்்ன 
அழுததி்னோல் நமல் மீடபுப் படடித ந்தோன்றும். 
அதில் Paste என்்ற கடட்ை்யத ந்தரவு 
கசய்தோல் , நகோப்பு புதிய இடததிறகு 
� க ர த ்த ப் ப டு ம் .

மு்்ற 2 – இழுததுவிடு்தல் 

• விணநடோஸின் இயகக வடடு சன்்னல் 
தி்ையில், இடது மறறும் வலது சோைைப் 
பிரிவுகள் உள்ை்ன. இடது சோைைப் பிரிவில் 
நகோப்பு மறறும் நகோப்பு்்றகள் மைக 
கி்ைகள் நபோல் கோடசியளிககும். வலது 
சோைைப் பிரிவில், இடது சோைைததில் உள்ை ஒரு 
குறிப்பிடட நகோப்பு அல்லது நகோப்பு்்றகள் 
பல்நவறு விருப்பஙகளுடன் கோடடப்படும். 

• இயகக வடடு சன்்னல் தி்ையில்  �கரத்தப்பட 
நவணடிய நகோப்பு அல்லது நகோப்பு்்றக்ை 
ந்தரவு கசயக. 

• வலது பகக சோைைததில் உள்ை நகோப்பு 
அல்லது நகோப்பு்்ற்ய இழுதது, இடது பகக 
சோைைப் பிரிவு நகோப்புப்படடியில் நசரககவும். 
பி்றகு சுடடியின் கபோத்தோ்்ன விடுவிககவும். 

• உஙகள் நகோப்பு அல்லது நகோப்பு்்றகள் 
புதிய பகுதியில் ந்தோன்றும்.

படம்  5.30. இழுதது விடு்தல் மு்்றயில் நகோப்பு 
அல்லது நகோப்பு்்ற்ய �கரதது்தல்.

5.11.6 நகோப்பு மறறும் நகோப்பு்்றக்ை 
� க க ல டு த ்த ல்
 நகோப்பு மறறும் நகோப்பு்்றக்ை 
�ககலடுகக பல வழிகள் உள்ை்ன.
மு்்ற 1
�ககலடுத்தல் மறறும் ஒடடு்தல்
1. �ககலடுகக நவணடிய நகோப்பு அல்லது 

நகோப்பு்்ற்ய ந்தரவு கசயக.
2. Edit → Copy  அல்லது Ctrl + C அல்லது 

சுடடியின் வலது கபோத்தோ்்ன அழுததி்னோல் 
நமல் மீடபுப் படடித ந்தோன்றும். அதில் Copy 
என்்ற கடட்ை்ய ந்தரவு கசயது புதிய 
இடததில் நகோப்பு்்ற்ய ஒடட நவணடும்.

3. ஒடடுவ்தறகு Edit → Paste அல்லது  Ctrl + V  
்யக கிளிக கசயய நவணடும்.

4. அல்லது, சுடடியின் வலது கபோத்தோ்்ன 

அழுததி்னோல் நமல்மீடபுப் படடித ந்தோன்றும். 

அதில் Paste என்்ற கடட்ை்ய ந்தரவு 

கசயக.

மு்்ற 2 இழுததுவிடு்தல்
1. வலது சோைைப் பகுதியில் �ககலடுகக 

நவணடிய நகோப்பு அல்லது நகோப்பு்்ற்யத 
ந்தரவு கசயய நவணடும்.

2. ந்தரவு கசய்த நகோப்பு அல்லது நகோப்பு்்ற்ய, 
இடது சோைைப் பகுதியில் நகோப்பு்்றப்படடியில் 
இழுதது விட நவணடும்.

3. புதிய பகுதியில் நகோப்பு மறறும் நகோப்பு்்ற 
ந ்த ோ ன் று ம்

3. புதிய இடததில் நகோப்பு அல்லது நகோப்பு்ை 
கோணப்படும்.

குறிப்பு

ஒன்றுககும் நமறபடட நகோப்பு 

அல்லது நகோப்பு்்ற்யத ந்தரவு கசயய  

Ctrl + Click ்யப் பயன்படுத்த நவணடும்.

5.11.6. நீககக கூடிய வடடிறகு நகோப்பு மறறும் 
நகோப்பு்்ற்ய �ககலடுத்தல்

 நீககக கூடிய வடடிலிருநது அல்லது 
வடடுககு ஒரு நகோப்பு அல்லது நகோப்பு்்ற்ய 
�ககலடுகக அல்லது அனுப்ப பல வழிகள் உள்ை்ன. 
1. �ககலடுத்தல் மறறும் ஒடடு்தல்

2. Send To
மு்்ற 1
�ககலடுத்தல் மறறும் ஒடடு்தல்
 USB flash இயககி்ய USB ல்  ந�ைடியோக 
இ ் ண க க வு ம் .
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• இ்ணககப்படட USB flash இயககி 
்தோ்னோக தி்றககவில்்ல எனில், கீழ்கோணும் 
வழிமு்்ற்யப் பின்பறறுக.

• Start→ Computer கிளிக கசயக. (படம் 5.31)
• நீககககூடிய இயககியுடன் க்தோடரபு்டய 

USB flash இயககி்ய இருகிளிக கசயக. 
இப்நபோது, USB இயககி தி்றககப்படும். (படம் 
5.32)

• �ககலடுகக நவணடிய நகோப்பின் மீது 
சுடடியின் வலது கபோத்தோ்்னக கிளிக கசயது 
ந்தோன்றும் நமல் மீடபுப் கபடடியிலிருநது, 
Copy ந்தர்வக கிளிக கசயக.

• இப்நபோது USB இயககிககு திரும்பி, கோலி 
இடததில், சுடடியின் வலது கபோத்தோ்்னக 
கிளிக கசயது, கி்டககும் நமல்மீடபுப் 
படடியிலிருநது, Paste ந்தர்வக கிளிக 
கசயயவும். (படம் 5.34)

மு்்ற – II Sent To
• USB flash இயககி்ய ந�ைடியோக USBல் 

இ்ணககவும்.

• நகோப்புகள் அடஙகியுள்ை நகோப்பு்்ற்யத 
தி்றநது ககோள்ைவும்.

• மோற்றப்பட நவணடிய நகோப்பின் மீது சுடடியின் 
வலது கபோத்தோ்்னக கிளிக கசயக.

• ந்தோன்றும் நமல்மீடபு படடியில், Send To 
என்்ற ந்தர்வக கிளிக கசயது, அதில் 
க்தோடரபு்டய USB flash இயககி்யத 
ந்தரவு கசயக. (படம் 5.35)

படம் 5.31 Start படடி மூலம் கம்ப்யூடட்ைத  

ந்தரவு கசய்தல்.

படம் 5.32 நீகக கூடிய இயககி்ய இைட்டக 
கிளிக கசய்தல்

படம் 5.33 சுடடியின் வலது கபோத்தோ்்ன Click 
கசயது நகோப்்ப �ககலடுத்தல்

6. நீஙகள் உருவோககிய நகோப்்ப ்ம 

கணினியில் இருநது D வடடு இயககிககு 

�கரத்தவும்.

 D:/ வடடி இயககியில் உருவோககப்படட 

நகோப்்ப நீககககூடிய இயககிககு 

ம ோ ற று க .

பயிறசி படட்்ற
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படம் 5.34 வலது கிளிக மூலம் ஒடடு்தல்

5.11.7. நகோப்பு மறறும் நகோப்பு்்றக்ை 

நீ க கு ்த ல்

• வடடு இயககிகளிலிருநது நகோப்பு அல்லது 

நகோப்பு்்ற்ய நீககும் நபோது அ்வ Recycle 
bin-ககு �கரும்.

நகோப்பு மறறும் நகோப்பு்்றகள் நீககு்தல்

 நீககப்பட நவணடிய நகோப்பு அல்லது 

நகோப்பு்்ற்யத ந்தரவு கசயது ககோள்க.

 சுடடியோல் நகோப்பு அல்லது நகோப்பு்்ற்ய 

வலது கபோத்தோ்னோல் கிளிக கசயயவும், நமல் 

மீடபு படடி ந்தோன்றும், அதிலிருநது Delete என்்ற  

விருப்பத்்தத ந்தரநக்தடுககவும். அல்லது வி்ச 

பல்கயில் Delete கபோத்தோ்்ன அழுத்தவும். 

நகோப்போ்னது நீககம் கசயயப்படடு Recycle bin-
ககு �கரத்தப்படும்.

 File → delete கிளிக கசயயவும்

7. நீஙகள் உருவோககிய நகோப்்ப My 
Document-ல் �ககலடுததுக ககோணடு,  

அ்த்்ன மூல பதிப்்ப நீககவும்.

பயிறசி படட்்ற

நீகக கூடிய இயககி 

Removable disk

படம் 5.35. Send to மூலம் நகோப்்ப �ககலடுத்தல்

குறிப்பு
 ஒரு நகோப்பு அல்லது நகோப்பு்்ற்ய 

நிைந்தைமோக கணிப்கபோறியில் இருநது 

Recycle bin-ல் ்தஙகோமல் நீகக SHIFT 

வி்சயுடன் Delete வி்சயும் நசரதது 

அழுத்த நவணடும்.

மறு சுைறசி க்தோடடி (Recycle bin) 

 மறுசுைறசி க்தோடடி என்பது, பய்னைோல் 
நீககப்படட நகோப்பு அல்லது நகோப்பு்்றகள், 
்தறகோலிகமோக நசமிககப்படும் சி்றப்பு 
நகோப்பு்்றயோகும். அழிககப்படட நகோப்புக்ை 
மீடகடடுகக இது மீணடும் ஒரு வோயப்்ப 
வைஙகுகி்றது.  மறுசுைறசித க்தோடடியிலுள்ை 
நகோப்புகள் மடடும் நகோப்பு்்றக்ை 
மீடகடடுககோமல் இயகக முடியோது.

 மறுசுைறசி க்தோடடியிலுள்ை ஒரு நகோப்பு 
அல்லது நகோப்பு்்ற்ய மீடகடடுத்தல்:

• தி்ைமுகப்பிலிருநது மறுசுைறசி க்தோடடி்யத 
தி்றககவும்.

• அதில், அழிககப்படட நகோப்புகள் அல்லது 
நகோப்பு்்றகள் ந்தோன்றும். மீடகடடுகக 
நவணடிய நகோப்பு அல்லது நகோப்பு்்றயின் 
மீது வலது கிளிக கசயயவும். அப்நபோது 
ந்தோன்றும் நமல்மீடபுப் படடியிலிருநது, Restore 
ந்தர்வக கிளிக கசயயவும்.
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• மறுசுைறசி க்தோடடியிலுள்ை அ்்னதது நகோப்பு அல்லது நகோப்பு்்றக்ையும் மீடகடடுகக, Restore all 
என்்ற பணிககுறி்யக கிளிக கசயயவும்.

• மறுசுைறசி க்தோடடியிலுள்ை அ்்னதது நகோப்பு அல்லது நகோப்பு்்றக்ையும் நிைந்தைமோக அழிததுவிட, 
“Empty Recycle bin” என்்ற பணிககுறி்யக கிளிக கசயயவும். 

5.12 முகப்புத தி்ையில் குறுககு வழி பணிககுறி்க்ை உருவோககு்தல்.

 உஙகள் நவ்ல்யத ்தோனியஙகியோக மோறறுவ்தறகு உஙகளுககு அடிககடி பயன்படும் நகோப்புகள் 
மறறும் நகோப்பு்்றகளின் குறுககு வழிக்ை உருவோககி, அ்்த முகப்புத தி்ையில் ்வககலோம்.  
தி்ை முகப்பில் நகோப்பு அல்லது  நகோப்பு்்றயின் குறுககு வழி்யத ந்தரநந்தடுககவும். வலது கிளிக கசயயவும்.

• ஒரு நமல்மீடபுப் படடி ந்தோன்றும். அதிலிருநது Send to  Desktop (Create Shortcut) என்்ற ந்தர்வ 
கிளிக கசயக.

• விணநடோஸ் தி்ைமுகப்பில், நகோப்பு அல்லது நகோப்பு்்றயின் குறுககுவழி பணிககுறி ந்தோன்றும். 
(படம் 5.36)

படம் 5.36 குறுககு வழி பணிககுறி  முகப்புத தி்ையில் உருவோககு்தல்

5.13. ஒரு கணிப்கபோறியிலிருநது மு்்றயோக கவளிநயறு்தல்

 அ்்னதது பயன்போடுக்ையும் மூடிவிடட பின்்னர, கணிப்கபோறியின் இயககத்்த மு்்றயோக 

நிறுத்தவிடடு கவளிநய்ற நவணடும்.

Logoff/shutdown கசயய:

• Start -> log off  அல்லது  Start -> Shut down கிளிக கசயக. (படம் 5.37) 
• ஏந்தனும் தி்றந்த நிைல்கள் இருககுமோயின் அ்்த மூடச் கசோல்லி விணநடோஸ் நகடகும், 

அவ்வோறு மூடோமல் விடடோல் கடடோயப்படுததி (Force Shut Down) மூடும், அ்த்னோல் நசமிககோ்த 
்தகவல்க்ை இைகக ந�ரிடலோம்.
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Figure 5.37. Log off ந்தரவு
• Switch User
 அடுத்த பய்னர கணககினுள் தி்றககப்படட 
நிைல்கள் மறறும் விணநடோஸின் கசயல்க்ை 
மூடோமநல நு்ைய விணநடோஸ் வழி வகுககும்.

• Log off
 தி்றநதுள்ை அ்்னதது நிைல்களும் முடிந்த 
பின்்னநை அடுத்த பய்னர கணககிறகு மோற்றம்  
கசயய இயலும்.

• Lock
 கணினி்ய விடடு க்தோ்லவில் இருககும் 
கபோழுது கணினி்யப் பூடடும் வசதி உள்ைது.

• Restart
 கணிப்கபோறி்ய மறு க்தோடககம் கசயவது 
(விணநடோஸ் இயகக அ்மப்பு நமம்படுததும் 
நபோதும் புதிய கமன்கபோருள் நிறுவும் நபோதும் இந்த 
விருப்பம் பயன்படும்).

• Sleep
 கு்்றந்த மின் சகதியில் கணிப்கபோறி 
இயகக இந்த நி்ல பயன்படும். இந்த நி்லயில் 
தி்றநது ்வககப்படடுள்ை அ்்னதது 
பயன்போடுகளும் இயஙகி ககோணடிருககும்.

 சூப்பர வி்ைவு மறுக்தோடககததிறகு 
விணநடோஸ்- ்யக கணினியின் நி்்னவகததில் 
இருநது தி்றககும்.

• Hibernate
 கு்்றந்த சகதியில் கணிப்கபோறி இருககும் 
நபோது எல்லோ இயஙகும் நிைல்களும் வி்ைவு 
மறுக்தோடககததிறகு கணினியின் வன்வடடில் 
விணநடோ்ைத தி்றககும்.

கசயல்போடு

மோணவர கசயல்போடு
1.  விணநடோஸ்  இயகக்மப்பில் நகோப்பு மறறும் 

நகோப்பு்்றக்ை உருவோககி ஒப்பிடவும்.

2.  விணநடோஸ் 7, விணநடோஸ் 8 மறறும் 
விணநடோஸ் 10 இல் ஒரு நகோப்பு / நகோப்பு்ை்ய 

உருவோககவும். அந்த ந�ைததில் நீஙகள் 
எதிரககோள்ளும் நவறுபோடுகள் குறித்த 
அறிக்க்யத ்தயோரிககவும்.

மதிப்போயவு

பகுதி – அ

சரியோ்ன வி்ட்யத 
ந்தரநக்தடுதது எழுதுக

1. கீநை ககோடுககப் 
படடுள்ைவறறுள்  இயகக 
அ்மப்பு  நிரவகிககும் 
கசயல்க்ைத ந்தரவு கசயயவும்

 (அ) நி்்னவகம்    (ஆ) கசயலி

 (இ) I/O சோ்த்னஙகள்

 (ஈ) இ்வ அ்்னததும்

2. விணநடோஸ் பயன்போடடில்  நகோப்புகள் 
ககோடோநி்லயோக எந்த நகோப்பு்்றயில் 
நசமிககப்படும்?

 (அ) My document
 (ஆ) My Picture
 (இ) Document and settings
 (ஈ) My Computer
3. எந்த இயகக்மப்பில் shift + delete என்்ற 
ந்தரவு நகோப்பு மறறும் நகோப்பு்்ற்ய நிைந்தைமோக 
நீககும்?

 (அ) windows 7
 (ஆ) windows 8
 (இ) windows 10
 (ஈ) இவறறில் ஏதும் இல்்ல
4. Windows XP/Windows 7 –ல் 
“்ைபரந்னட”என்ப்தன் கபோருள் என்்ன?

  அ) Safe modeல் கணினி்ய 
மறுக்தோடககம் கசய்தல்.

  ஆ) hibernate modeல் கணினி்ய 
நிறுதது்தல்.

  இ) இயககததில் இருககும் 
பயன்போடுக்ை நிறுததிய பி்றகு 
கணினி்ய நிறுதது்தல்.

  ஈ) இயககததில் இருககும் பயன்போடுக்ை 
நிறுத்தோமல் கணினி்ய நிறுதது்தல்.

5. சோைைஙகளில் ஒரு நகோப்பின் மறுகபயரிட 
பயன்படுத்தப்படும் குறுககுவழி வி்ச

 (அ) F2  (ஆ) F4
 (இ) F5  (ஈ) F6
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பகுதி – ஆ

குறுவி்னோககள்

1. பல்பணியோககம் என்்றோல் என்்ன ?

2. கசந்தை பணிககுறி என்்றோல் என்்ன ?

3. நகோப்பு மறறும் நகோப்பு்்றககு உள்ை விததியோசஙகள் யோ்வ?

4. Save மறறும் Save As-ககு உள்ை விததியோசஙகள் யோ்வ?

5. ஒரு நகோப்்ப எவ்வோறு மறுகபயரிடுவீரகள்?

பகுதி – இ

சிறுவி்னோககள்

1.  விணநடோஸ் இயகக அ்மப்பின் கசயல்போடுகள் யோ்வ?

2.  மறுசுைறசி கபடடி்ய பறறி ஒரு குறிப்பு வ்ைக.

3. விணநடோஸ் சன்்னல் தி்ைக கூறுக்ைப் பறறி குறிப்பு வ்ைக.

4. ஒரு நகோப்பு்ை்ய உருவோககும் இைணடு வழிமு்்றக்ை  எழுதுக.

5. கவடடு்தல் மறறும் �ககலடுத்தல்- ககுப் உள்ைநவறுபோடுகள் யோ்வ?

பகுதி – ஈ

க�டுவி்னோககள்

1.  விணநடோஸ் இயகக அ்மப்பின் பலவ்கயோ்ன பதிப்புக்ை விவரி.

2.  ஒரு நகோப்பு அல்லது நகோப்பு்ை்ய ந்தடிக கணடுபிடிககும் பல்நவறு வழிமு்்றக்ை விைககுக. 

3.  விணநடோஸ் இயகக அ்மப்பில் குருககு வழி பணிககுறிக்ை உருவோககும் கசயல் மு்்ற்ய 
விைககுக-ல் குறுககுவழி்ய உருவோகக கசயல்மு்்ற எழு்தவும்.

கசோறகைஞ்சியம்

இயகக அ்மப்பு
அ்மப்பு கமன்கபோருைோ்னது பி்ற கமன்கபோருளுடன் 

க்தோடரபுககோள்வ்தறகும் மறறும் வன்கபோருள்க்ைச் கசயல்படுததுகி்றது

சுடடி
ஒரு GUI - இல் ஒரு சுடடி்யக கடடுப்படுததுகின்்ற ் கயு்்ற வன்கபோருள், 

உள்ளீடு சோ்த்னம் மறறும் உ்ை குறும்படஙகள், நகோப்புகள் மறறும் 

நகோப்பு்்றகள் ஆகியவற்்ற �கரத்தவும், ந்தரநக்தடுககவும் முடியும்.

விணநடோஸ் ்மகநைோசோப்ட நிறுவ்னம் உருவோககிய பிைபலமோ்ன இயகக அ்மப்பு.

தி்ைமுகப்பு விணநடோஸ் இயகக அ்மப்பின் முகப்புதி்ை

குறும்படம் ஒரு கடட்ை்யக குறிககும் சிறிய படம்

நகோப்பு்்ற நகோப்புக்ை உள்ைடககிய ககோள்கலன்

லி்னகஸ் ஒரு இயகக அ்மப்பு
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